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Introduction

· General

This edition of the NSCS specification has been prepared for use with Eurocodes and has been co-ordinated with the standard for execution BS EN 13670. It assumes in clause P1.2.1 that design has been carried out in accordance with the Eurocodes.

It is very strongly recommended that the NSCS Third Edition be used for projects designed to other codes. If this edition is to be used with design carried out to another code – for example BS8110 this must then be stated in both clauses P1.2.1 and P 1.6.

A key intention of the NSCS is that its use simplifies both the production of a project specification and the understanding of that document by the Constructor who is going to carry out the work. That is why the document text cannot be altered and the document layout and format has been fixed so that any project changes can easily be identified when reviewing the specification during the tender process. Clauses P1.13 and P2.9 will expand and allow the addition of any amount of extra information required for a project.

· Document Use
This edition of the NSCS is available in Microsoft Word Form, as a template; the advantages of this are:

· The fixed text cannot be altered in error

· Where the input choice is known to be limited “pull down menus” simplify the choice of input, while allowing editing if required.
The template has an additional menu, “NSCS”, next to the standard Word “help” menu that describes the features of the template designed to assist in completing the document for use as a Project Specification; this includes the replacement features to allowing editing of text that cannot be done using standard Word commands.

When a specification is partially completed and circulated within a project team those who want to edit it will need to have the template document available on their computer so that the editing features work as described. Details for installing the template file are given in appendix A.

The template can be used with Word 1997 or any later version. If an unsupported version of Microsoft Word is used to create or open a document, then a Warning Message is shown in the opening dialog box. 

Navigation

The NSCS Template Project Specification, on opening, creates a new word document “document X”, with the first Field, “Project Name”, automatically selected. To move from one field to another, use any of the following keys:

[up arrow] or [tab] – goes to the next Field

[down arrow] or [shift]+[tab] – goes to the preceding Field

[left arrow], [right arrow] – moves the cursor within the characters (if any) of a Field, or goes to the next/previous field if the cursor is after the last character in the Field or before the first character the Field.

Or click the pointer on the dark grey highlight in the required Field.

Help

When a new document is created or an existing document opened, a Help dialog is displayed. This can be dismissed by clicking [Close], and recalled at any time either by: pressing [ctrl]+[shift]+[?] or selecting “Show Help” from the “NSCS” menu. The “Help” dialog contains the notes in this document.

Formatting and Editing

The usual Word commands to allow text to be selected and formatted do not function (as explained in appendix A) and are replaced by short cuts or “NSCS” menu commands for formatting, cut, copy and paste as described below. 

To select the format for a field before starting to type into it select “Format” from the “NSCS” menu and choose the format required - bold, italic, underline; or either superscript or subscript.  If normal is chosen this clears any previous formatting, before any other styles are applied; if normal is not chosen, then any styles chosen are added to those previously applied to the selected text. Click OK to confirm the format chosen.

To select individual words for formatting, to add bold or other style after typing for example, click the cursor immediately in front of or into the word to be formatted and then press [ctrl]+[shift]+[F] or select “Format” from the “NSCS” menu. Note it is not necessary try to select the entire word in the usual way for editing.

These shortcuts used on selected text control formatting directly:

[ctrl]+[B] - Toggle Bold text on/off

[ctrl]+[I] - Toggle Italic text on/off

[ctrl]+[U] - Toggle Underline text on/off

[ctrl]+[+] - Toggle Superscript text on/off

[ctrl]+[=] - Toggle Subscript text on/off

The use the Cut Special and Copy Special functions, which work in the same way as the standard Word Cut and Copy functions, select the required text as described above, then:

For Cut: Either: Press [ctrl]+[shift]+[X] or select “Cut Special” from the “NSCS” menu

For Copy: Either: Press [ctrl]+[shift]+[C] or select “Copy Special” from the “NSCS” menu

If the selected Field is not a Text Entry Field then an error message will be displayed.

To use the Paste Special function, cut or copy the required text then:

Select the required target, either in the standard way or by positioning the cursor before or inside the target word and

Either: Press [ctrl]+[shift]+[V] or select “Paste Special” from the “NSCS” menu

If the selected Field is not a Text Entry Field then an error message will be displayed.

Note: The Paste Special function maintains character formatting - bold, italic, highlighted text etc. Only the font and font size are converted to that of the target Field.
When the Paste Special function is used to paste content copied from other documents, it is possible to paste graphics as well as text into a Text Entry Field.

 Other Word items, such as Tables, Bookmarks, Cross-references and Text Boxes must not be pasted as this usually destroys the document.
Data Entry

Fields are shown with a light grey background. Users may enter information only in these areas of the template. It is not possible to select/modify other areas of the template. 
· Text Entry Fields

These are initially shown as a small dark grey highlight within the light grey box. Just type the words or values that are to appear e.g: “Test Project” – for the project name. The entered text word-wraps automatically, and the space required to accommodate it expands. Users should consider the effect of long text strings in some tables where the table as a whole may read more clearly if the additional information is given in clause P1.13 or P2.9 and the entry in the table is just “see P1.13” or “see P2.9”. 

The following Text Entry Fields initially contain explanatory text. This text should be selected, which can be done by double left clicking on it, and typed over with the required data;
P1.1.1 Project contacts, other parties– “name”. User to enter a name or title for each entry.
P1.2.2 Loading – “Other”. User to enter type of load, if any, other than those listed in the table.

P1.2.3 Other Design Data – “Other”. User to enter type of design data, if any, other than those listed in table.

P1.4.3 Standard specification clause ref. – “Other”. User to enter reference required.

P1.3 Drawings & Calculations – “Enter details as required”. User to enter type of drawings etc. if any, other than those listed in table. Note - this row can be duplicated in the table if required.

P1.10 Precast Concrete – “Enter requirements”. User to enter Environmental Certification details, if any.

P1.11.3 Other prestressing information required – User to enter type of prestressing information required, if any, other than those listed in table.

· Drop Down Entry Fields

The possible values of these are predetermined. They are initial shown as a “-“ on a small dark grey highlight within the light grey box. 
On selecting a Drop Down Field, a small arrow is displayed. Click on this arrow to show a list of possible values e.g.: “Yes” or “No” and select the one required. Note if a Drop Down Field is selected by clicking on it with the pointer, rather than selecting the Field with the arrow or tab keys, then the small arrow and the menu are shown immediately.

Although it is usually simpler to select a value from a Drop Down List with the pointer, when a List is displayed, the [up arrow] and [down arrow] keys will scroll through the List, and the [enter] or [return] keys may be used to select the required value.

If the choices available in a Drop Down List do not include the required value, the User may add an extra option to the list by selecting the relevant Drop Down Field, and with the list closed and either pressing [ctrl]+[shift]+[D] or selecting “Drop List Special” from the “NSCS” menu. In the displayed dialog, enter the text for the new option and click OK. The new option will be added to the Drop Down List and is automatically selected.

If the selected Field is not a Drop Down Field then an error message will be displayed.

Note: the new option is limited to 40 characters in length. Drop Down Fields do not have word-wrap, so the User may have to further limit the length to fit into the width of the column in which the Field occurs.  If more characters, or word wrapped characters, are needed, after entering the text for the new option in the Drop Down Dialogue, click “More”. A second text box is displayed and additional text can be entered into this second text box and the action is confirmed by clicking “Accept”. The additional text will be displayed alongside or below new option. It will word wrap, and it may be up to 256 characters long.

An added option cannot be removed from the List, but any of the original values may be reselected, and further new options can be added.

· Extending Tables

Most Tables can be extended, or duplicated, to provide more space for inputting information than initially shown on the template; this allows for additions that can be seen more clearly than just by adding text in a single box that expands as described above. The Fields for data entry are automatically included in the extension. 

To extend a table:

Select any Field in an extendable Row or Table to be duplicated.

Press [ctrl]+[shift]+[m] or Select “Add Row/Table” from the “NSCS” menu

The Row or Table will be copied and pasted into the appropriate point in the template, and its new Fields reset to their initial, blank, condition. This usually happens very quickly, but when many Fields have to be reset, e.g. the 1.8 Tables which have over 20 Fields to reset, it may take a few seconds. On completion, the first Field of the new Row/Table is automatically selected.

If the selected Field is not in an extendable Row or Table that can be duplicated, an error message is displayed.

To remove a previous extension/duplication:

Select any Field in the Row or Table to be deleted.

Either press [ctrl]+[shift]+[L] or Select “Delete Row/Table” from the “NSCS” menu

A confirmation message is displayed. Select “Yes” to confirm deletion.

The selected Row or Table will be deleted. Any data in this Row/Table cannot be recovered. On completion, the first Field of what was the following Row/Table will be automatically selected, or the first Field in last Row/Table if the last Row/Table was deleted.

If only one Row or one copy of the Table exists when the user attempts to delete it an error message is displayed. 

The extendable tables are:

Revisions – Additional rows for each to record each revision of the completed specification can be added.

P1.1.1 Other named parties to the contract – Additional rows for other named parties can be added.

P1.1.2 Description of the project works – Additional rows can be added if the description needs to be split into several separate items.

P1.1.3 Construction planning requirements – Additional rows can be added to each of the subsections if the corresponding requirement needs to be split into several separate items.

P1.2.1 General– Additional rows can be added if the requirements need to be split into several separate items.
P1.2.2 Loading – Additional rows for other loads can be added.

P1.2.3 Other design data – Additional rows for other design data can be added; the heading “other” can be edited to describe the load type..

P1.2.4 Special requirements for composite structures – Additional rows can be added if the requirements need to be split into several separate items.

P1.3 Specialist Drawings – Additional rows can be added for each type of specialist drawing required.

P1.4.1 Execution class – Additional rows can be added if the description needs to be split into several separate items.

P1.4.3 Approvals timing – Additional rows for other approvals can be added.

P1.4.5  Documents: special documentation – Additional rows can be added if the description needs to be split into several separate items.

P1.4.5  Documents: responsible sourcing – Additional rows can be added if the description needs to be split into several separate items.
P1.4.6 As built geometry: overall concrete – Additional rows for overall dimensions can be added.

P1.4.6 As built geometry – Additional rows for overall cover to reinforcement can be added.

P1.4.7 Curing class – Additional rows for curing classes can be added.

P1.4.8 Protection – Additional rows can be added if the description needs to be split into several separate items.
P1.5.1 Reinforcement – Additional rows can be added to each of the subsections if the corresponding requirement needs to be split into several separate items.

P1.5.2 Timber – Additional rows can be added if the requirement needs to be split into several separate items.

P1.5.3 Other materials – Additional rows can be added to each of the subsections if the corresponding requirement needs to be split into several separate items.

P1.6. Project Requirements – Additional rows for project variations to requirements of the NSCS can be added.

P1.11 Prestressed Concrete Construction Requirements – Additional rows can be added if the requirement needs to be split into several separate items.
P1.11.2 Stressing sequence – Additional rows for the stressing sequence can be added.

P1.11.3 Other prestressing Information required – Additional rows for other information can be added.

P1.12.1 Deflection allowances: formwork – Additional rows for design deflections can be added.

P1.12.2 Deflection allowances: precast – Additional rows for design deflections can be added.

P1.13 Further Information – Additional rows for further information can be added

P2.1 Other specialist contractors to be used by Constructor – Additional pairs of rows for further named specialist contractors can be added.

P2.2 Design Additional rows can be added if the design description needs to be split into several separate items
P2.3 Drawings and Calculations Additional rows can be added if the proposed variation needs to be split into several separate items
P2.4.2 Other execution management proposals – Additional rows can be added if the proposals needs to be split into several separate items.

P2.5 Materials Additional rows can be added if the proposed alternative needs to be split into several separate items
P2.6 Project Requirements Additional rows can be added if the proposed alternative needs to be split into several separate items
P2.8 Concrete Additional rows can be added if the proposed variation needs to be split into several separate items
P2.9 Further information – Additional rows for further information can be added
The tables that can be duplicated are:

P1.8.1 Designated concretes – The whole of this page can be duplicated, providing space for another four types, should the space for the initial four be insufficient.

P1.8.2 Designed concretes – The whole of this page can be duplicated. Each Designed Concrete should be entered on a separate page.

P1.8.3 Prescribed concretes – The whole of this page can be duplicated, providing space for another four types, should the space for the initial four be insufficient.

P1.8.4 Standardised prescribed concretes – The whole of this page can be duplicated, providing space for another four types, should the space for the initial four be insufficient.

P1.8.5 Proprietary concretes – The whole of this page can be duplicated, providing space for another four types, should the space for the initial four be insufficient.

P1.9.2 Surface Finishes – The whole of this table can be duplicated and placed below the existing table.

· Special Functions

To help speed up production and avoid typing errors the following fields have special entry features:

Date, on the revisions box: This converts to the form “dd/mm/year” so that it will fit in the column; unless the date is entered as “5th” when the “th” results in a date of “01/mm/year”. 

P1.1.1 Project Contacts: The Project Name and Project Reference are automatically copied to this field from the cover page.

P1.2.2 Loading – The Fields for Total imposed load and Total dead load are calculated automatically as the sum of the relevant preceding loads.

P1.9.1 Reference Panels – The drop down fields contain the addresses for the CONSTRUCT panels, these are selected by regional location from a drop down field; the address is added when “Refresh” is selected from the “NSCS” menu. Note this “refresh” can take a few moments.

P2.1 Project Contacts: The Project Name and Project Reference are automatically copied to this field from the cover page.
Headers & Footers

· Headers

There are two headers, one for the cover, initially blank, and one for the rest of the document, initially NSCS Project Specification in white on a grey background.

These headers may be customised by using the contents of the user's clipboard; this is best taken from the Header of an existing Word document. This header may contain formatted text, graphics, pictures or any combination thereof but should not contain Word references or bookmarks. Select and copy the text and/or graphics required from an existing document.

The margins on the document from which a header or footer is copied should be the same as those of the template:

Top 2.00 inches, for Cover Header, or 1.00 inch for Main Header.
Left  & Right 0.43 inches for Cover Header/Footer, or 0.50 inches for Main Header.
Bottom 0.5 inches for Cover.
Having copied the header required return to the NSCS Template Project Specification document, and select “Change Header/Footer …” from the “NSCS” menu and on the displayed dialog, select which Header is to be replaced, “Change Cover” or “Change Main”.
This action cannot be undone, but may be repeated as necessary to achieve the desired appearance.

· Footers

The cover page default footer is blank; the footer for the rest of the document is inserted automatically as either the Project Name or Project Reference, as entered in the first or second field on the cover page of the document, together with the page number and page count. To choose whether the Project Name or Project Reference is shown select ”Change Header/Footer …” from the “NSCS” menu and on the displayed dialog, select which is to be displayed in the main body Footer, Name or Reference.

To insert a footer on the first page of the document select “Change Header/Footer …” from the “NSCS” menu, and the “change footer” option, this pastes the clipboard contents into the first page footer. This action cannot be undone, but may be repeated as necessary to achieve the desired appearance.

After changing any header or footer, the change may not be visible until the “Refresh Now” option on the “NSCS” menu is selected.
Saving and Distribution

As the template is protected to preserve the formats and allow the controls described to work the resulting document cannot be protected as a normal Word document. As it is intended that the specification will anyway require input from several parties this means that when circulated electronically it can be edited, provided the person wanting to edit the document has the template document available on their computer – so if the content needs to be fixed at some stage for a contract issue, for example, this issue should be produced as a printed document. Where a secure electronic copy is required a password protected pdf of the template can be produced using normal commands. 
Document Revisions

As those receiving the document need to be aware of any changes made and these need to be clearly identified, as required in clause 4.2.3.1 of the Execution Management section of the NSCS Standard Specification the changes should all be listed in the revisions table on the document cover page and all the added or amended text within the document should be highlighted so that it can be easily identified.

To choose the highlight colour required:

Select “Change Highlight Options…” from the “NSCS” menu

On the displayed dialog, click on the required highlight colour: Red, Yellow, Green, Cyan or Pink; the selected colour will continue to be used for highlighting until it is changed.

To highlight selected text using the previously selected colour either: Press [ctrl]+[shift]+[E]
or select “Highlight” from the “NSCS” menu.


Note 1: None is provided to enable correction of text that has been highlighted in error.

Note 2: Highlighting may be applied to Drop Down Fields as well as Text Entry Fields. The Field must be selected and Drop Down List closed when the highlight is applied.

Note 3: It is possible to reset all highlighting back to none; select “Highlight” from the NSCS menu and on the displayed dialog click “Reset All”.

All highlighted text, including that in Drop Down Fields, will be changed to default, none.

Appendix A: Technical

Installation

The template is provided in the .dot format.

Although it is generally recommended that users of Microsoft Word 2007, and later versions, use the .dotm format for macro enabled templates, documents produced from these are not fully compatible with earlier versions of Microsoft Word, which are in common use throughout the Construction Industry. Thus to ensure maximum compatibility and free exchange of NSCS Project Specifications, the use of .dotm templates is not recommended at this time. Further, users of Word 2007 should ensure that NSCS Project Specifications produced using this Template are saved using the [Word 97 – 2003 Document] option, the .doc format.

To obtain the latest issue of the Template, go to www.construct.org.uk/publications.asp , where it has been extensively tested and proven to be virus-free. If the Template is provided by a third party, then it is the installer should check the reliability of this source.

In order to maintain compatibility with Project Specifications produced or modified by other users, the Template’s file name must remain unchanged.

It is essential that the VBA macros contained in the Template are enabled on the user’s computer system. All Microsoft Office Applications guard against unauthorised use of macros, and the method for enabling them varies depending on the configuration of the user’s system. If the user’s computer is part of a large managed network system, then this task is best left to the system’s IT manager or his team.

The following instructions are intended for single users and for smaller systems without a computer systems manager specialist. The principle suggested here is to store the Template in, what Microsoft Word regards as, a “trusted location”. Doing this avoids the need to change macro security levels, or to make decisions on the fly about whether or not to run a set of macros. The template may also be installed and used in many other ways – far too numerous to list and describe here. Users seeking to use alternative methods should check with Microsoft Help that such methods will enable the template’s macros and will protect the template from being overwritten accidentally.

For Word 2007

This Template should be installed with other “User Templates”.

To determine the path to the appropriate folder, select:
[Developer ribbon] > [Macro Security] > [Trusted Locations]
and look under “Description” for “User Templates”. The corresponding path will be displayed. The check box “Disable all Trusted Locations” should NOT be checked.

Insert your copy of the NSCS Project Specification Template into this folder.

To create a new, blank project specification, open a New document, using the Template:

[Office button] > [New] > [My Templates] > [NSCS Proj Spec] > [OK]
For Word 2003 / Word 2002 / Word 2000
This Template should be installed with other “General Templates”.

To determine the path to the appropriate folder, select:
[Tools] > [Options] > [File Locations]
and look under “File Types” for “User Templates”. The corresponding path will be displayed.

Insert your copy of the NSCS Project Specification Template into this folder.

The option for trusting installed add-ins and templates should be enabled

Word 2000 [Tools] > [Macro] > [Security…] > [Trusted Sources]

Word 2002 [Tools] > [Options] > [Security] > [Macro security] > [Trusted Sources] 

Word 2003 [Tools] > [Options] > [Security] > [Macro security] > [Trusted Publishers] 

and ensure the corresponding check box is checked.

To create a new, blank project specification, open a New document, using the Template:

[File] > [New] > [General Templates] > [NSCS Proj Spec] > [OK]

Customising the Template

Although the fixed text of the template may not be changed, Users may customise the template when they intend that the customised result will be used to create NSCS Project Specifications for several projects. 

The simplest form of customisation is to set the headers and/or footers to contain Company specific information, address, logo, etc. that will appear on all future Project Specifications created by the Company. 

More complex customisation may be carried out by adding pre-set text into Data Entry Fields; so that a Companies general requirements, that vary from the NSCS standard – possibly for responsible sourcing etc., are contained in all their Project Specifications; or Company specific additions could be made to drop down entry fields to further speed up production of Company standard Project Specifications.

Before creating a Customised Template, thought must be given as how it will be used and saved. Specifically, whether it will be saved with same name as the standard Template or whether it will be saved with a different file name:

If the Customised Template is saved with same name as the Standard Template, but obviously in a different folder, then it is accessible to any person in the Company to use it to create new Project Specifications, and these Project Specifications can be added to and modified by other companies using the Standard Template.

If the Customised Template is saved with a different name to that used for the Standard Template, then only those companies to whom a copy of the Customised Template is supplied will be able to add or modify Project Specifications produced from it; so to share the NSCS as intended both the customised template and Project Specifications produced from it will have to be distributed.

Documents produced from a Customised Template can always be read using standard Word.

To customise the Template:

Open the Template file itself – not a document created from it.

Save it with [Save as …] using the file name and location as determined above.

Load the required header and footer information, and relevant data into the appropriate fields, either directly, or by copy and pasting from the relevant Company source documents.

Add information to identify the customisation:

Press [ctrl]+[shift]+[>] to bring up the dialog (there is no menu item to select this),
enter the information in the text box, and click [OK].

This information is free text and will be displayed on the [Versions] tab of the Help dialog, following the word “Customised “. Typically, this information may contain, company name, date, etc. E.g.: “by ACME Inc. 17/06/2010”
Note that this dialog will only be displayed if the current document is a template. If the document is not a template the shortcut will be ignored. There is no error message.
Also, although the customisation information can be freely changed, it cannot be deleted.

Save the Customised Template (again).

Editing in Form Fields within Tables

Editing in a Form Field within a Table is a little different to editing normal text. Definitive instructions may be obtained from Microsoft Help. The following is a suggested guide for Users who are unfamiliar with Form Fields within Tables.

The standard alphanumeric keyboard works as normal, together with punctuation marks, [shift], [caps lock], [backspace] and [delete]. Use the pointer [single click] or [left arrow] [right arrow] to change the insertion point. 

New paragraph ([return] or [enter]) and new line ([shift]+[return] or [shift]+[enter]) can be used as necessary within a Field, however it is recommended that only the latter, new line, is used - see below.

The normal MS Word operations [Copy], [Paste] and [Cut] can be used within a Text Entry Field, and also to import text from other documents into the Field. Note that Paste removes any formatting information, resulting in plain text only.

The usual [left click, hold and drag], or [left click] move and [shift]+[left click] operations to select text do not work as normal. Instead these operations select all the text up to the insertion point, or all the text after the insertion point, depending on whether the new position is to the left (nearer the beginning) or to the right (nearer the end) of the insertion point. (The reason for, and value of, this feature of Microsoft Word is unknown.)

For Word 2002 or later, to select an individual word, [double left click] within the word or between the word and the first white space or punctuation mark to its right. However, if the word is followed (anywhere - not necessarily immediately) by a new paragraph (but not a new line), then the selection made will be from the start of the current word to the end of the Field. The functions provide by the Template as described above overcome these limitations.

To select the whole Field use [triple left click] or [ctrl]+[left click].
Appendix B: Responsibilities

The copyright of the NSCS Project Specification Template is the property of CONSTRUCT Limited.

Computer files, documents and other material derived by using the NSCS Project Specification Template are the property and copyright of the persons, companies or organisations, who have undertaken to use the NSCS Project Specification Template.

The NSCS Project Specification Template may be distributed freely within the user’s company or organisation, and to the clients, customers, contractors and such other persons, companies and organisations as have need of it in furtherance of the user’s normal business.

The NSCS Project Specification Template may not be published on a publicly accessible internet website without the consent of CONSTRUCT Limited.

All data, information and opinions contained herein aim to reflect accepted practice at the time of publication.

While every effort has been made to ensure accuracy, no responsibility can be accepted for errors and omissions, however caused. No responsibility for any loss occasioned as a result of material in this publication nor in the NSCS Project Specification Template is accepted by CONSTRUCT Limited, nor by the authors and publishers. Responsibility for interpretation of the material contained in this publication and in the NSCS Project Specification Template rests entirely with the user.
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